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Quick-Start Guide for Submitting to OLJ 
Before submitting, authors must complete the OLJ Submission Checklist and ensure all 
requirements are met. 

Step 1: Prepare Your Manuscript 
●​ Prepare a blinded manuscript using APA 7th edition formatting. 
●​ Include all required sections: 

○​ Abstract (≤250 words) and Keywords (3–5) 
○​ Introduction, Literature Review, Methods, Results, Discussion, Conclusion 
○​ References 

●​ Include required transparency statements (as applicable): 
○​ Ethics/IRB approval or exemption 
○​ Funding 
○​ Conflicts of interest 
○​ AI use disclosure 
○​ Data availability 

●​ Ensure the manuscript: 
○​ Is original and not under review elsewhere 
○​ Aligns with OLJ’s scope (online/blended learning research) 
○​ Does not focus solely on evaluating a specific tool without broader implications 

●​ Keep the manuscript under 10,000 words (including references) 
●​ Prepare a separate title page including: 

○​ Full names of all authors 
○​ Institutional affiliations 

⚠️ Important: All authors must be listed in the submission system at the time of submission. 
Changes after submission may result in rejection. 

Step 2: Format Your Manuscript 
●​ Use Times New Roman, 12 pt, single-spaced 
●​ Set 1-inch margins 
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●​ Include page numbers and a running head 
●​ Place all tables and figures within the text 
●​ Ensure all formatting follows APA 7th edition guidelines 

Step 3: Ensure Proper Blinding 
To maintain the integrity of double-blind peer review, manuscripts must be fully anonymized 
prior to submission. 

Authors must: 

●​ Remove all names, affiliations, and identifying information from the manuscript 
●​ Replace self-citations with “Author (year)” where appropriate 
●​ Remove identifying metadata from the file (e.g., document properties) 

⚠️ Important: Failure to properly blind a manuscript may result in immediate return or rejection. 

➡️ See Microsoft Word Blinding Instructions for detailed steps. 

Step 4: Prepare Figures and Tables 
Figures and tables should support—not duplicate—the text. 

Authors must: 

●​ Place all figures and tables within the manuscript at appropriate locations 
●​ Include clear titles, labels, and legends 
●​ Ensure all visuals are accessible: 

○​ Include alt text 
○​ Use high-contrast, readable formatting 
○​ Ensure readability in grayscale 

➡️ See Guidance for Accessible Figures for full requirements and examples. 

Step 5: Final Submission Steps 
Before submitting, confirm that: 

●​ The manuscript and title page are uploaded as separate files 
●​ All authors are entered correctly in the submission system 
●​ All required metadata and checklist items are completed 



 
⚠️ Important: Incomplete submissions or missing author information may delay review or result 
in rejection. 

Step 6: Screening and Review 
All submissions are screened for: 

●​ Scope and quality 
●​ Plagiarism and text recycling 
●​ Undisclosed or inappropriate AI use 

Manuscripts that do not meet these requirements may be declined prior to peer review. 

Common Reasons for Immediate Decline: 

●​ Out-of-scope topic 
●​ Missing required statements 
●​ Manuscript not blinded 
●​ Undisclosed AI use 
●​ Incomplete authorship information 

 

 



 

Quick Policy Guide for Authors 
This guide summarizes key policies for submission to the Online Learning Journal (OLJ). 
Authors should review the full Author Guidelines and Submission Checklist prior to submission. 

1. Scope and Suitability 

OLJ publishes original research on online and blended learning, primarily in higher education. 

●​ Submissions must demonstrate clear relevance to online or blended learning 
●​ Studies focused solely on evaluating specific tools without broader pedagogical or 

design implications are out of scope 

⚠️ Important:​
 Out-of-scope manuscripts may be declined prior to peer review. 

2. Submission Requirements 

All submissions must: 

●​ Be original and not under review elsewhere 
●​ Follow APA 7th edition formatting 
●​ Include all required sections and declaration statements 
●​ Be fully blinded for peer review 
●​ Include complete and accurate authorship information at submission 

Incomplete submissions may be returned or declined prior to review. 

3. Authorship 

All authors must meet ICMJE authorship criteria and be listed at the time of submission. 

●​ All authors must approve the manuscript and agree to submission 
●​ Changes to authorship after submission require justification and may result in rejection 
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4. Peer Review 

OLJ uses a double-blind peer review process. 

●​ Manuscripts are evaluated by expert reviewers 
●​ Reviewers and authors remain anonymous 
●​ All participants are expected to follow COPE ethical guidelines 

5. Ethics and Research Integrity 

Authors must adhere to ethical research and publication practices. 

●​ Human subjects research must include ethics approval or justification 
●​ All manuscripts are screened for plagiarism, text recycling, and AI-generated content 
●​ AI use must be disclosed in the manuscript 

⚠️ Important:​
 Violations of research integrity policies may result in rejection or retraction. 

6. Conflicts of Interest 

Authors must disclose any relationships or activities that could influence the research. 

7. Publication and Access 

●​ OLJ is an open-access journal under a Creative Commons Attribution (CC BY) license 
●​ Authors retain copyright of their work 
●​ Articles are published quarterly and indexed in major databases 

Common Reasons for Desk Rejection 

●​ Out-of-scope topic 
●​ Missing required statements 
●​ Incomplete or incorrect authorship information 
●​ Manuscript not properly blinded 
●​ Undisclosed AI use or integrity concerns 

Questions or Concerns 

For inquiries regarding submissions or policies, contact the Managing Editor. 

 



 

What Does OLJ Look for in a Manuscript? 
To ensure quality, clarity, and alignment with the journal’s mission, all submissions must meet 
the expectations outlined below. Manuscripts that do not meet these criteria may be declined 
prior to peer review. 

1. Scope and Relevance 
Manuscripts must: 

●​ Focus on online and/or blended learning, primarily in higher education 
●​ Demonstrate clear relevance to teaching, learning, instructional design, or educational 

practice 
●​ Go beyond evaluation of a specific tool or technology to include broader pedagogical, 

theoretical, or design implications 

⚠️ Out-of-scope submissions may be declined without review. 

2. Originality 
Submissions must: 

●​ Be original work that has not been previously published 
●​ Not be under consideration by another journal 
●​ Demonstrate a clear contribution to existing scholarship 

3. Manuscript Quality and Organization 
Manuscripts must: 

●​ Be clearly written, well-organized, and free of grammatical errors 
●​ Follow APA 7th edition formatting 
●​ Include all required sections: 

 



 
○​ Abstract and Keywords 
○​ Introduction 
○​ Literature Review 
○​ Research Questions or Hypotheses 
○​ Methods 
○​ Results 
○​ Discussion and Implications 
○​ Conclusion 
○​ Required declaration statements (e.g., ethics, funding, AI use, conflicts of 

interest) 
○​ References 

4. Research Design and Methods 
Manuscripts must demonstrate methodological rigor and transparency. 

Authors should: 

●​ Clearly describe the research design and justify methodological choices 
●​ Provide sufficient detail on participants, data collection, and analysis 
●​ Align methods with the stated research questions 
●​ Acknowledge limitations and methodological constraints 

⚠️ Insufficient methodological detail or misalignment between research questions and 
methods may limit suitability for review. 

5. Transparency and Replicability 
Submissions must include sufficient detail to allow evaluation and, where appropriate, 
replication. 

This includes: 

●​ Clear description of study design and procedures 
●​ Explanation of variables, instruments, and analytical approaches 
●​ Inclusion of supporting materials (e.g., appendices or data availability statements) where 

appropriate 

6. Ethical Compliance and Disclosure 
Manuscripts must include required statements related to: 



 
●​ Ethics approval or exemption 
●​ Funding sources 
●​ Conflicts of interest 
●​ AI use 
●​ Data availability (if applicable) 

⚠️ Missing or incomplete disclosures may result in return or rejection prior to review. 

7. Writing and Scholarly Contribution 
Manuscripts should: 

●​ Present a clear and coherent argument 
●​ Situate findings within existing literature 
●​ Offer meaningful contributions to research, practice, or policy in online and blended 

learning 

8. Formatting and Submission Requirements 
Submissions must: 

●​ Be in Microsoft Word format 
●​ Be fully blinded for peer review 
●​ Include all authors in the submission metadata at the time of submission 
●​ Follow all journal formatting and submission guidelines 

⚠️ Failure to meet submission requirements may result in delays or rejection. 

Common Reasons for Desk Rejection 

●​ Manuscript is out of scope 
●​ Research design is unclear or insufficiently described 
●​ Missing required statements (e.g., AI use, ethics) 
●​ Manuscript is not properly blinded 
●​ Incomplete or inaccurate authorship information 
●​ References are inaccurate or unverifiable 

 



 

Author Guidebook 
This guidebook provides detailed guidance for preparing a high-quality manuscript for the 
Online Learning Journal (OLJ). It is designed to support authors in meeting the journal’s 
expectations for rigor, clarity, transparency, and scholarly contribution. 

This document complements the OLJ Submission Checklist and Author Guidelines. Authors are 
expected to review all materials prior to submission to ensure compliance with journal 
requirements. 

Purpose of This Guide 

The Author Guidebook: 

●​ Explains the purpose and expectations of each manuscript section 
●​ Provides guidance on APA style, structure, and academic writing 
●​ Supports authors in producing clear, rigorous, and replicable research 

This guide is not a template. For formatting requirements, please refer to the OLJ Formatting 
Guide and Template. 

What OLJ Values in a Manuscript 
Successful submissions to OLJ demonstrate: 

●​ Relevance: Clear connection to online or blended learning 
●​ Rigor: Appropriate and well-explained research design and methods 
●​ Transparency: Sufficient detail to support evaluation and replication 
●​ Contribution: Meaningful implications for research, practice, or policy 

Before You Continue 
Before developing or submitting your manuscript, confirm that: 

●​ Your study aligns with OLJ’s scope 
●​ Your manuscript includes all required sections and statements 
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●​ All authors meet authorship criteria and are prepared to be listed at submission 

Title Page and Author Information 
A separate title page must be submitted with your manuscript. This page includes all 
author-identifying information and is not shared with reviewers. 

The title page must include: 

●​ Full title of the manuscript 
●​ Full names of all authors 
●​ Institutional affiliations for each author 

Authorship Requirements 

All listed authors must meet OLJ’s authorship criteria and must: 

●​ Have made a substantial contribution to the work 
●​ Approve the final version of the manuscript 
●​ Agree to be accountable for the content 

All authors must be entered in the submission system at the time of submission. 

⚠️ Important: 

●​ The author list in the submission system is the official record used for publication. 
●​ The title page must match the submission metadata exactly. 
●​ Changes to authorship after submission require justification and approval from all 

authors and may result in rejection. 

Authorship Integrity Notice 

Submissions in which the listed authors are not directly involved in the submission 
process, or where authorship information is incomplete or inconsistent, may be flagged 
for investigation. 

Submission System (Metadata) Requirements 

When submitting your manuscript: 

●​ Enter all authors in the order they should appear in publication 
●​ Ensure names and affiliations are accurate and complete 
●​ Confirm that all authors have agreed to submission 



 

Failure to include all authors at the time of submission may result in delays, authorship 
disputes, or rejection. 

Formatting Notes 

●​ Author names and affiliations should follow APA 7th edition guidelines 
●​ Keep formatting clear and consistent 
●​ Do not include author-identifying information in the blinded manuscript 

➡️ See the OLJ Formatting Guide for detailed examples. 
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Authorship and Contributorship Policy 

Online Learning Journal (OLJ) follows the authorship criteria established by the 
International Committee of Medical Journal Editors (ICMJE). All listed authors must 
meet all of the following criteria: 

1.​ Substantial contributions to the conception or design of the work; or the 
acquisition, analysis, or interpretation of data 

2.​ Drafting the work or revising it critically for important intellectual content 
3.​ Final approval of the version to be published 
4.​ Agreement to be accountable for all aspects of the work 

Authorship Requirements 

●​ All authors must meet ICMJE criteria and must be listed at the time of submission 
●​ All authors must approve the submitted manuscript and agree to its submission 
●​ The corresponding author is responsible for ensuring that all listed authors meet 

these requirements 

⚠️ Important:​
 Submission of a manuscript implies that all listed authors have reviewed, approved, 
and consented to submission. 

Contributorship Transparency (CRediT Taxonomy) 

OLJ encourages authors to identify individual contributions using the CRediT 
(Contributor Roles Taxonomy) (e.g., Conceptualization, Methodology, Writing – 
Original Draft). 

Providing contribution details improves transparency and may be requested during 
editorial review. 

Authorship Changes 

Requests to add, remove, or reorder authors after submission: 

●​ Must be approved by all listed authors 
●​ Must include a clear written justification 
●​ May be reviewed under COPE authorship guidelines 

https://credit.niso.org/


 

⚠️ Important:​
 Authorship changes after submission are strongly discouraged. Unjustified or disputed 
changes may result in rejection of the manuscript. 

Authorship Integrity and Misconduct 

OLJ takes authorship integrity seriously. The following may be considered grounds for 
investigation or rejection: 

●​ Submission by an individual who is not a listed author 
●​ Incomplete or inaccurate authorship information at submission 
●​ Undisclosed third-party involvement in manuscript preparation or submission 
●​ Disputes regarding authorship that cannot be resolved by the authors 

Submissions flagged for authorship concerns may require additional verification or 
documentation. 

 
 

 
 
 

 



 

Abstract and Keywords 

Abstract 

The abstract provides a concise summary of the study and should allow readers to 
quickly understand the purpose, approach, and key findings of the research. 

Abstracts must: 

●​ Be no more than 250 words 
●​ Be written as a single, double-spaced paragraph 
●​ Accurately reflect the content of the manuscript 

A strong abstract clearly includes: 

●​ Purpose: The research problem or objective 
●​ Methods: The study design, participants, and approach 
●​ Results: Key findings (not anticipated outcomes) 
●​ Conclusions: Main implications or contributions 

Abstracts should be: 

●​ Clear, concise, and specific 
●​ Free of citations and unnecessary background information 
●​ Written in a neutral, scholarly tone 

⚠️ Important: Abstracts that are vague, omit results, or do not clearly describe the study 
design may limit the manuscript’s suitability for review. 

Keywords 

Provide 3–6 keywords that accurately represent the content of the manuscript. 

Keywords should: 

●​ Reflect the main topics, methods, or theoretical frameworks of the study 
●​ Support indexing, discoverability, and reviewer selection 
●​ Use commonly recognized terms within the field of online and blended learning 

Avoid: 

●​ Overly broad terms (e.g., “education,” “technology”) 
●​ Redundant phrases already included in the title 

 
 
 



 

Introduction 
The introduction establishes the foundation for the study by clearly defining the research 
problem, its significance, and its relevance to online or blended learning. 

The introduction should: 

●​ Clearly state the focus and purpose of the study 
●​ Explain the significance of the problem or topic 
●​ Situate the study within the context of online and/or blended learning 
●​ Provide a brief overview of relevant research (not a full literature review) 
●​ Conclude with a clear statement of the research questions, objectives, or 

hypotheses 

The introduction should guide the reader from broad context to the specific focus of the 
study. 

Literature Review 
The literature review situates the study within existing scholarship and establishes the 
foundation for the research questions. 

A strong literature review should: 

●​ Synthesize relevant research (not simply summarize individual studies) 
●​ Integrate both theoretical/conceptual and empirical literature as appropriate 
●​ Identify gaps, tensions, or limitations in existing research 
●​ Clearly demonstrate how the current study addresses those gaps 

The literature review should lead directly to the study’s research questions or 
hypotheses. 

Methods 
The methods section must provide a clear and transparent description of how the study 
was conducted, allowing others to evaluate and, where appropriate, replicate the 
research. 

The methods section should include: 

●​ Research Design: Description and justification of the study design 
●​ Participants/Sample: Source, characteristics, and selection procedures 
●​ Data Collection: Instruments, procedures, and variables measured 
●​ Data Analysis: Analytical methods and tools used 
●​ Ethics: Institutional approval or justification for exemption 
●​ Limitations: Acknowledgment of methodological constraints 



 

Methods must be described with sufficient detail to support transparency, rigor, and 
replicability. 

⚠️ Important:​
 Misalignment between research questions, methods, and analysis may limit the 
manuscript’s suitability for review. 

Common Issues in Submissions: 

●​ Research questions not clearly stated 
●​ Literature review summarizes rather than synthesizes 
●​ Methods lack sufficient detail for evaluation 
●​ Misalignment between methods and findings 

Results 
The results section presents the findings of the study in a clear, organized, and objective 
manner. 

The results should: 

●​ Directly address the stated research questions or hypotheses 
●​ Present findings in a logical sequence 
●​ Report results without interpretation or speculation 
●​ Use tables and figures where appropriate to enhance clarity 

Results should focus on what was found, not what the findings mean. 

Discussion 
The discussion interprets the results and explains their significance in relation to the research 
questions, existing literature, and broader context. 

The discussion should: 

●​ Interpret findings in relation to the research questions or hypotheses 
●​ Connect results to prior research and theoretical frameworks 
●​ Discuss implications for online and/or blended learning practice, research, or policy 
●​ Acknowledge limitations and their impact on interpretation 
●​ Suggest directions for future research 

The discussion should extend—not repeat—the results. 

Conclusion 
The conclusion provides a concise synthesis of the study and its contributions. 

The conclusion should: 



 

●​ Summarize the key findings and their significance 
●​ Reinforce the study’s contribution to the field 
●​ Highlight practical, theoretical, or research implications 
●​ Avoid introducing new data or analysis  

Common Issues in Submissions: 

●​ Results include interpretation or discussion 
●​ Discussion repeats results instead of extending them 
●​ Findings are not clearly linked to research questions 
●​ Conclusions do not articulate the study’s contribution 

 



 

Required Declarations and Statements 
All manuscripts must include the following statements in an end matter section (typically placed 
after the conclusion and before the references). These statements support transparency, 
research integrity, and compliance with journal policies. Authors may use the sample language 
provided as a guide, but are responsible for ensuring statements accurately reflect their study. 

Acknowledgments (if applicable) 

Use this section to recognize individuals, institutions, or organizations that contributed to the 
work but do not meet authorship criteria. 

●​ Do not include individuals who qualify as authors 
●​ Obtain permission before naming individuals 

Ethics Statement 

All studies involving human participants must include an ethics statement. 

Include: 

●​ Name of the approving institutional review board (IRB) or ethics committee 
●​ Approval number (if applicable) 

If ethics approval was not required, provide a clear justification. 

Funding Statement 

Authors must disclose all sources of financial support for the research. 

●​ If funding was received, include the funding organization and grant number 
●​ If no funding was received, state:​

​
​
 “This research received no external funding.”​
 

AI Use Statement 

Authors must disclose any use of generative AI tools in the preparation of the manuscript. 

Include: 

●​ The tool(s) used 
●​ The purpose of use (e.g., editing, formatting) 

AI tools must not be used to generate, analyze, or interpret research data. 

➡️ See the Use of Generative AI Policy for full guidance. 
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⚠️ Important:​
 Failure to disclose AI use may result in rejection or retraction. 

Conflicts of Interest Statement 

Authors must disclose any financial, professional, or personal relationships that could influence 
the research. 

●​ If no conflicts exist, state:​
​
​
 “The authors declare no conflicts of interest.”​
 

Data Availability Statement (if applicable) 

Authors should indicate where supporting data can be accessed. 

Examples: 

●​ Public repository link 
●​ Available upon reasonable request 
●​ Not available due to privacy or ethical restrictions  

 

Manuscripts missing required statements may be returned for revision or declined prior to peer 
review. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Tables, Figures, and Visual Elements 
Tables and figures should enhance clarity and support the presentation of results. Use 
visual elements only when they improve understanding beyond what can be 
communicated in text. 

General Requirements 

All tables and figures must: 

●​ Be placed within the manuscript at appropriate points 
●​ Be clearly labeled and referenced in the text 
●​ Follow APA 7th edition formatting guidelines 
●​ Be accurate, readable, and free of unnecessary complexity 

Tables 

Tables should be used to present structured data clearly and concisely. 

●​ Include a clear title and any necessary notes 
●​ Follow APA formatting conventions 
●​ Avoid duplicating information already described in the text 

Figures (e.g., graphs, charts, images) 

Figures should visually represent data or concepts in a way that enhances 
interpretation. 

●​ Include a descriptive caption and legend (if applicable) 
●​ Ensure all text and symbols are legible 
●​ Design figures to remain clear when printed in grayscale 

Accessibility Requirements 

All visual elements must meet accessibility standards: 

●​ Include alt text describing the content and purpose of the figure 
●​ Use sufficient contrast between text, lines, and background 
●​ Do not rely on color alone to convey meaning 
●​ Ensure figures and tables are readable for all users 

➡️ See Guidance for Accessible Figures for detailed instructions and examples. 

File Preparation 

●​ Submit figures in standard formats (e.g., embedded in Word; separate image files 
if needed) 



 

●​ Ensure all images and graphics are high quality and readable  

 

Common Issues with Tables and Figures: 

●​ Figures submitted in color 
●​ Figures missing alt text 
●​ Tables not formatted in APA style 
●​ Visuals that duplicate text without adding value 
●​ Poor readability or low contrast 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

References 
All references must follow the most recent APA 7th edition guidelines and be 
presented as a complete and accurate record of the sources cited in the manuscript. 

General Requirements 

References must: 

●​ Be formatted according to APA 7th edition 
●​ Be listed in alphabetical order with a hanging indent 
●​ Include all sources cited in the text and only those sources 
●​ Be complete, accurate, and verifiable 

Authors are responsible for ensuring that all reference information is correct, including 
author names, publication details, and links. 

DOIs and URLs 

●​ Include a DOI (Digital Object Identifier) for all references where available 
●​ If no DOI is available, include a stable URL when applicable 
●​ Ensure all links are active and accessible 

Accuracy and Integrity 

References must reflect actual, accessible sources. 

⚠️ Important: 

●​ Inaccurate, incomplete, or unverifiable references may delay review or result in 
rejection 

●​ Fabricated or non-existent references are considered a violation of research 
integrity 

Formatting Guidance 

Refer to APA Style guidelines for detailed formatting of: 

●​ Journal articles 
●​ Books and edited volumes 
●​ Book chapters 
●​ Conference proceedings 
●​ Online sources 

Common Issues with References: 

●​ Missing DOIs or broken links 



 

●​ References not cited in the text 
●​ Inconsistent APA formatting 
●​ Citations that do not correspond to real or accessible sources 

Appendices and Supplemental Materials 
Appendices and supplemental materials may be used to provide additional detail that 
supports the transparency, reproducibility, and application of the study. 

These materials should enhance—not replace—the main manuscript. 

Appendices 

Appendices are included within the manuscript and provide supporting material that is 
directly referenced in the text. 

Appropriate uses include: 

●​ Data collection instruments (e.g., surveys, interview protocols) 
●​ Coding schemes or analytical frameworks 
●​ Additional tables or figures that support interpretation 
●​ Expanded methodological detail 
●​ Instructional materials or rubrics used in the study 

Requirements: 

●​ Each appendix must be referenced in the main text 
●​ Content must be directly relevant to the study 
●​ Appendices should be clearly labeled (e.g., Appendix A, Appendix B) 

Supplemental Materials 

Supplemental materials are separate from the manuscript and provide additional 
resources that support transparency or reuse. 

Examples include: 

●​ De-identified datasets 
●​ Multimedia materials 
●​ Software code or scripts 
●​ Extended data visualizations 

Authors should briefly describe supplemental materials in the manuscript and explain 
how they support the study. 

Appropriate Use 



 

Appendices and supplemental materials should: 

●​ Support replicability, transparency, or practical application 
●​ Provide information that would interrupt the flow of the main text 
●​ Be clearly connected to the study’s methods, analysis, or findings 

Inappropriate Use 

Do not include: 

●​ Materials that are not referenced in the manuscript 
●​ Excessive or unstructured qualitative excerpts 
●​ Content that does not directly support the study 
●​ Personally identifiable or restricted data without appropriate permissions 

Common Issues with Appendices: 

●​ Appendices not referenced in the manuscript 
●​ Inclusion of excessive or irrelevant material 
●​ Lack of clarity about how materials support the study 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Guidance for Accessible Figures 
To ensure that all readers—including those using assistive technologies—can access and 
understand visual content, all figures must meet accessibility standards. 

1. Provide Descriptive Alt Text 
Alt text (alternative text) provides a concise description of a figure’s content and purpose. 

●​ Focus on what the figure shows and why it matters 
●​ Keep descriptions clear and concise (typically 1–2 sentences) 
●​ Do not describe purely visual details that do not add meaning 

Example:​
 “Bar chart showing online course completion rates by age group, with the highest rate among 
learners aged 25–34.” 

2. Use High-Contrast, Readable Design 
●​ Ensure strong contrast between text, lines, and background 
●​ Avoid light colors on light backgrounds or low-contrast combinations 
●​ Use fonts that are clear and legible at a minimum of 10 pt 

➡️ Tools such as contrast checkers can help ensure readability. 

3. Do Not Rely on Color Alone 
Color should not be the only way information is conveyed. 

●​ Use labels, patterns, or shapes in addition to color 
●​ Ensure charts remain understandable when printed in grayscale 

4. Label Clearly and Directly 

 



 

●​ Use clear, descriptive labels for axes, categories, and data points 
●​ Avoid requiring readers to rely solely on legends when possible 
●​ Keep visuals as simple and uncluttered as possible 

5. Include Captions and Legends 
●​ Every figure must include a caption explaining its purpose and relevance 
●​ Place legends where they are easy to interpret (typically below the figure) 

6. Ensure File Quality and Readability 
●​ Use high-quality images that remain clear when resized or printed 
●​ Ensure all symbols, lines, and text are legible 
●​ Avoid overly complex or dense visualizations 

7. Describe Complex Figures in the Text 
For complex figures (e.g., diagrams, multi-layered visualizations): 

●​ Provide a brief explanation in the manuscript text 
●​ Highlight key takeaways to support reader understanding 

Common Accessibility Issues 

●​ Missing or vague alt text 
●​ Low contrast or hard-to-read visuals 
●​ Overly complex or cluttered figures 
●​ Reliance on color alone to convey meaning 

⚠️ Accessibility Requirement 
All figures must meet accessibility standards, including the use of alt text and readable design. 

Failure to meet accessibility requirements may result in requests for revision prior to review or 
publication. 

 



 

Microsoft Word Document Blinding Instructions 
To ensure the integrity of the double-blind peer review process, all manuscripts must be fully 
anonymized prior to submission. 

Blinding includes removing all identifying information from: 

●​ The manuscript text 
●​ File properties (metadata) 
●​ Comments and tracked changes 

⚠️ Important:​
 Failure to properly blind a manuscript may result in return or rejection prior to review. 

Step 1: Remove Author Information from the Document 
●​ Delete all author names, affiliations, and acknowledgments from the manuscript 
●​ Replace self-citations with neutral placeholders (e.g., Author, year) 
●​ Remove any identifying references to institutions, projects, or locations where possible 

Step 2: Remove Metadata (File Properties) 

On Windows (PC) 

1.​ Open the document in Microsoft Word 
2.​ Go to File → Info 
3.​ Select Check for Issues → Inspect Document 
4.​ Ensure Document Properties and Personal Information is selected 
5.​ Click Inspect, then Remove All 
6.​ Save the document 

On Mac (macOS) 

1.​ Open the document in Microsoft Word 
2.​ Go to Tools → Protect Document 
3.​ Select Remove personal information from this file on save 

○​ If unavailable: go to File → Properties and remove identifying information 

 



 

manually 
4.​ Save the document 

Step 3: Remove Identifiers from Comments and Track 
Changes 

●​ Go to the Review tab 
●​ Remove or accept all tracked changes 
●​ Delete any comments that include identifying information 

To anonymize reviewer/user names: 

●​ Update your Word user name to a neutral value (e.g., “Reviewer”) 
●​ Save the document after making changes 

Step 4: Final Check 
Before submission: 

●​ Search the document for your name, institution, or identifying terms 
●​ Ensure all self-citations are anonymized 
●​ Confirm no identifying information remains in text, comments, or metadata 

Save the file with a neutral name (e.g., Manuscript_Blinded.docx). 

Common Blinding Issues 

●​ Author names left in file properties 
●​ Self-citations not anonymized 
●​ Institutional references in the text 
●​ Identifying information in comments or tracked changes 

 



 

Author Promotion Toolkit 
Share your research. Expand its impact. 

The Online Learning Journal (OLJ) encourages authors to actively promote their publications to 
increase visibility, readership, and impact. 

1. Share on Social Media 
Promote your article using platforms such as LinkedIn, X (Twitter), or Threads. 

Best Practices: 

●​ Include your article title and a brief, engaging summary 
●​ Share the DOI or direct link to your article 
●​ Tag @online-learning-journal when possible 
●​ Use 2–3 relevant hashtags 

Suggested Hashtags:​
 #OnlineLearning #HigherEd #EdTech #InstructionalDesign #Accessibility #AIinEducation 
#BlendedLearning #OLJ 

Sample LinkedIn Post 

Excited to share our latest publication in the Online Learning Journal! 

📘 Title: [Insert Title]​
 🔍 Focus: [1–2 sentence summary of key findings or contribution] 

This study explores [brief insight or implication]. 

Read more: [DOI link] 

#OnlineLearning #OLJ #EdTech 

 



 

2. Write a Short Summary or Blog Post 
Consider writing a brief, accessible summary of your research for a broader audience. 

Suggested Structure: 

●​ What the study explored 
●​ Key findings (2–3 points) 
●​ Why it matters for practice or research 

Example Opening: 

We recently published a study in the Online Learning Journal examining [topic]. Our findings 
highlight [key insight], with implications for [audience or context]. 

3. Increase Visibility Across Platforms 
●​ Add your article to your email signature, CV, or faculty profile 
●​ Share with your institution (e.g., teaching center, communications office) 
●​ Deposit your article (if permitted) in an institutional repository 
●​ Present your findings at conferences, webinars, or workshops 

4. Engage with the Community 
●​ Share your work in professional networks and communities 
●​ Highlight practical implications for educators and instructional designers 
●​ Encourage discussion and collaboration 

💡 Why Promotion Matters 
Active promotion increases: 

●​ Visibility and readership 
●​ Citations and academic impact 
●​ Engagement with practitioners and researchers  

Tip: Focus on Impact, Not Just Promotion 

When sharing your work, highlight: 

●​ What problem your study addresses 
●​ What your findings change or clarify 
●​ How others can apply your work 
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